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1.1 Swift #i2

® {tA= Swift

Swift £ Apple £ WWDC2014 Frafli—MeHimiEas, AR A&I0S 1 Mac OS X RFH.
Swift 325 Objective-C B, FM Python #1 JavaScript sh{E4E TR, (#48 Swift ENNEE. 5
i, BI7E Mac OS X 10.9.4 RELIHRA, Xcode 6 RELAEhRADER, S BEE* swift,

Swift IESE/FESE, Apple 7Bt Swift i, #ARFEERN Objective-C 147, FWEBILISCILESR .
{EEIREHBEEARAARNER, Swilt 2522EUT Objective-C, AR I0S 8. OS X Yosemite BIHi7

® Swift S

1. E377F C 70 Objective-C 552 L, RB7T C 5 Objective-C iR, EREBN—KTS
MRIERT CHRE, RRT CiIESHFREMTM.

2. R, B, &£, Bxl, MELELTF Objective-CiES.

3. HEENRABRIBSMARIES Cocoa. Cocoa Touch HHES, HET—1TRBAM
Framework Library, #FREZ2HmEE. :

4. BT —LEIAaOTheE, EHRESMER. BINRIE. EAF#@. Xcode Playgrounds IhEER
Swift AFFARTEHEROSALIR, ZINEERMHEBANENBR, sEiL Switt IBESHIGTEFLH ERE
ETER.

5. Apple EFEARRmIEE. A28, ERMEAEEMEME. BT ARC (Automatic Reference
Counting, Bzhs|FitH#) KEHWAFER.

® #Objective-C 77, B4

Swift AT Objective-C s ZSHFINNENRIEE BT T4EEAIE Cocoa ERLURS
Objective-C B#mHIBEN . (EEFRETF Objective-C F1 C++3E C fERE—.mm {4EhEESR,
Swift {£#848E#0 Objective-C RKIBBER—N32{4 .

® Swift EEEHTAFES

Swit BENEZEREEESZE. EREESH. ERHATBEREANBEEIFNES. Bthd
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RE |ESHFRERIEROTE. IX, SSMMIHR—LEERNEATE (HME2EN5 IR,
Automatic Reference Counting ) i, SERBEETT A B—LEMNATE, IEARKRERREENG
Fk, BARFHEMFEARNSAUMNSLE, EEEEmHiRK.

Objective-C FrE&ESRE Swift FIEIEMEIR. Swift T Objective-C HIHESEHFNEERIR
&8, 18tk Objective-C, Swift B LRIRHEE. RERNBEHE—17, HMNABEZ L. =4, B
Objective-C tBEESLHA D INEE, BRATEMBREK, MEAFHEHEE., GLHMAOTIEEEH, B
Objective-C RERFEFSILATILE, BEA Swit MR—FPRENZZ ., BELARBRREER
£ SwiftiE=.

Swift JFFHEFRBERFN. BRI RSRNEAREES, MNEHAES NIRRT, ©
#F playground, SFRERRRINIE—ER Swift (CRBINAEFHZEIBRIER, MABMBAEEILET—
NZFH .

EFRER, & Swit IBERE—XNEER. XBREWMIER Swit iIBEFA—1 App, &
PEHMEEANE Swit FFEERANR, FELK TR Aop FRITAIIES N IDEGRIAT, LUFESHA
Xt Swift IBSBEFA TR, ILEZRARAE—HE SWit EEER.

1.2 BEARRKIR

HF Swift FAMMEFERE Mac OS X &&GirhiafT, RICERBHEEREART Windows HiE.
TENE Swit FAMEAEESE, HIEEaEEFtERESMAA T EMESHTHIENBFA .

1.2.1 HARKIRAIER

® fEf

1. FEREBMK (MacBook Pro. MacBook Air, iMac. Mac mini. Mac Pro ).

2. iPhone. iPod Touch 5% iPad 2%, EZRFNHARSIFAIER (MNRLBUEME, FTLUER
Xcode 1#E#I281E1T ).

® I

1. FERERSZ Mac OS X ( BIRARZMAFAHREI OS X 10.9.4 RLAE ).

2. Xcode FF&TE ( Xcodeb.0 FLAE ).

1.2.2 ZEFEKIRHEE

® IIEINEHAR :
NERGFHREIEH Mac OS X ARRAFRZE 10.9.4 RELAEIRA . NREFXMRAE, Bi17ET
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FFF#f0 Xcode 8 (dmg 3244 ) BF, £%T Xcode HEZILLERFS, WA 1-1 Fis. W Xcode
SERLIE T RFRANERIET, WE 1-2 .

- Xcode

| Xcode

Applications

B 1-1 #HAZEH5H Xcode #EH

FLAEF“Xcode X MRATES IHEEN
os X EAfEA.

SHERHE OS X 10.9, HEMEFAR 05X 10.9.4 %
L e

(@) [ wumEs | | 8 |

H1-2 MAZERNERTER

RN RBESRZAARESRIRARE . 1T ‘BOE LHNERER>REERR...”, NE
1-3 P #{I2EE AppStore RARIEFHFE, WNE 1-4 Fir. REEIENRE, RALLER
TERLZE, NEEMEISRHRANER.,

App Store...

REMITIRN. ..
Dock

BEEANTE
APNES. ..

R
B ETD. .
R

FEf“LUuMingYang”... ©#Q

H1-3 #AARGEHERTHE
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1 e A

3 BT
X

REEFAREHTROAER
Client ## 3.7.1 WE
it SR E LRI AR B SR IIY.
Copyraght © 2014 Apale Ine. REFRREH BABLNR | BRESE | FERR 6

1-4 AppStore %4 E #H A&

ARZE, AlRE ‘BOELBRERER>XTAI, B8 1-5 Fim. EHFHXTFANRE
HEERREFRRSS, 0E 1-6 B,

App Store...

RORIFIZE...
Dock

BR{EAmE
EHLRE...

FEER
B RE...
xH...

E#“LiuMingYang”...

B 1-5 XTAUBEHETHE

5
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0S X

WA 10.9.5
_ nAEE..

458 2.5 GHz Intel Core i5
A% 8GB 1600 MHz DDR3
BRWE Macintosh HD
EHER..

TM # © 1983-2014 Apple Inc.
RE—DRA. HTDR

B1-6 *TF&H

RGEFHRZ G, WEHEFFFEA Xcode R3E (dmg X4 ), HIIEE Xcode L%EFHE, WE 1-7
B

Xcode.app Applications

Drag to install Xcode in your Applications folder

B 1-7 E# Xcode X% R®
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F# Mac OS X Yosemite ( 10.10 BLAEARA ), OS X BRI2®#ZRS, £RFIISS Apple ID
ME. BERTHAEOT.

1. BidEsMusRiEAEF, Mac FFAERMIEHE hitps:/developer.apple.com/devecenter/
mac/index.action.

2. BB AMBERTHLRE .

WNRi@IT App Store T, THE=REECEHIENERER4ER, NE 1-8 Fimx.

H1-8 MABFAHFTRUARLTEE

Wik “LHE OS X Yosemite Developer Preview.app” BILABERIRERSs, I TIHLLEEIEES,
LERGAIC LAER N R TAY Time Machine.app #{7&15

® HIEURETE

BE U 2%, SELNERADRERIVEFNINEE. 17 ‘UAREF-THRTE-Kix" BA®S
“defaults write com.apple.finder AppleShowAllFiles YES” [ElZ, @& 1-9 Fis. 1IBH&E, =55
[Ba) Finder, BingE “‘BOA EAERIE>EFIRE>Finder>&#H/350" .

4 “&%E 0S X Yosemite Developer Preview.app” S ~82KE, WA 1-10 fix.
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Last login: Wed Sep 24 06:39:02 on console
Lliumingyangdembp:~ LiuHuiTong$ defaults write com.apple.finder AppleShowAllFiles

YES
liumingyangdembp:~ liumingyang

H1-9 SFRALEREXHHLTRETEE

tAam |
@ mwomase |
@ AirDrop {

& wm

B } SRMAT ,
O T8 | E#"&% OS X Yosemite Developer Preview” i
? F§"%% OS X Yosemite Developer Preview 3R EX & ..
@ | "9 ‘
& wmem 2 RS Bp
Elosxa.. & | PEER "R OS X Yosemite Developer Preview”
[k ! E3 > _—
@ liminghui-pc #M"R% OS X Yosemite Developer Preview”
; BERETEN N
#Rid...

| i | o® 209 @
ne | e

B 1-10 #%& 0SX Yosemite Developer Preview.app M X A %

#HANBES Content—>SharedSupport W InstallESD.dmg 175, I EZIfEE 4 Base
System.dmg, @& 1-11 .
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1

DS_Store BaseSystem.chunklist BaseSystem.dmg Packages

M 1-11 InstallESD H &k

IRANAEF>LATE>HATR, BERREFEAN U BIRE, KEKkE, ¥ Base
System.dmg XHHEER#EENVE, ¥ U RIEFIBIFHENE, oE6 TAKERE, WE 1-12
B o

2 OV % Inuat ESD

| 711 128,08 GB PLEXTOR PX-12

@os

£ 750,16 GB Generic Externa. e
EARRem

A SuperDishe RS

)

o InstallESD.dmg
. 05 XInstal ESD
2 BaseSystem.dmg

LEl b

i Yosemite’

1 WOA: [Volumes Yosemis HR: 20 GE (19,999,997,952 F7)
) Wk Mac O PR A 19.69CB (19,853,450,.992 FT)
BRMNEE: & BEM: 106.5 M8 106,536,960 F5)
KAXRN & R 2

 1-12 ¥4 BaseSystem.dmg W 23| U # &

FIShETEESRSHE FNREHIE, WE 1-13 R
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| 126.04 GB PLEXTOR P

| =

h o 8 o B LA ; : |
i3 “’“’" —
[ mmREm

| ) Superinve RN

|5 InstallESD.dmg
; . 05 X Install ESD
|!"Bsesvswn.dmg

H1-13 #HEUEZRERT

WwETME, 7 U & Easts, #ANBR “System-Installation”, Feiiis Package ix/MiiE
Eity nu 1—14 Fﬁo

7 .D5_Store
 file

[ fseventsd »

il Spotlight-v100 -

B Trashes

& vol »
¥ 2K OSXY..loper Preview

8 Applications

@ bin

@ dev

&8 etc

[ Library

(i private

il tmp r
@ usr M
2 var »
{3 Volumes ~

H1-14 kARGZEUENE
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BEZETHE OS X Install ESD AR Packages X438 #Z “System - Installation” B®
mr QU[EI 1—15ﬁﬁ7.|__\‘c

1443 MR/A6A CE - 0 3 A0

M 1-15 4% #| Packages X%

¥ OS X Install ESD .dmg 3{4A|Y BaseSystem.dmg 5 Basesystem.chunklist E4I%I U £2
RIRERN, W& 1-16 Fis.

E3 05X Buse Stem

bt R e

EGW 0 P RAMMITOS X Sase System”

il B & = =

L3 Lbrary private

B 1-16 0S X Install ESD dmg A X4 %12 U SR E &
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ENERE, BIRERSRESIE4RE . X1~ USB RARBHMEEFT . @ﬁ%%ﬂ%ﬁiﬁﬂgnpv
2 “defaults write com.apple.finder AppleShowAllFiles NO”,

® %3 Mac OS X 10.10
17 ‘BN tANERER>EHE...", ERNEE, #RIRME option #, MSHIEM

|EERE, ®BEUE, EAZENRE, 08 1-17 Fix.

7

‘ﬂn\w

OS X Yosemite

BERHEE 05 X 10.10, REER".

2

B 1-17 O0S X Yosemite XX EZ R @

nﬁﬁ%g 3 iﬁ)\fﬂiﬂ:ﬂf’bﬁzﬁﬁ 1 gu 1 _1 8 Fﬁ o

0OS X Ybsemite

E L o L

oF CLICKING
.-wmm-vmm-.wm_v—mm

IMPORTANT

meﬂmmﬁmm&qu

ELTY nn

H 1-18 0S X Yosemite %% # F il K&
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EEFEINY, HEAZEERFRRE, W0E 1-19 Fix.

X

- "
“ P

OS X Yosemite

0S X #&R4@M"Macintosh HD" 1.

Macintosh HD

e 9

B 1-19 0S X Yosemite %% R4 & £ BRE
ERERTEFINRSR, [k, HARZRERE, WE 1-20 .

OS X Yosemite

EEARER. RGNS ARE 2.

H1-20 £%k#*KRE

13
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Z3+ o HNRE, ZEGERZRE, #iiFlZE LT OS X Yosemite RSt .

1.2.3 Xcode AR IBEEE

MEH B ERHKER, salblziE Xcode 6.0.1 HESHRA. App Store B TEMILE:
https:/itunes.apple.com/cn/app/xcode/id4977998357mt=12, BIMETLAE—LWEBTE, TH
EESER, Eid App Store TEAY Xcode S ERE FHEIBMNBRERMAER, THMNZE, R
FEWHETAE, NRECEEMNN_ETE, THTRAR dng . Mac ERERIZERESR,
FAFTFF dmg 324, TTLAEZ “Drag to install Xcode in your Applications folder”, & 1-21 B
™, BEHEMER Xcode FIGILMNARFNHFEE, TR Xcode, EESEHMHTEN, WE
1-22 Ffim~o

Xcode.app Applications

Drag to install Xcode in your Applications folder

M 1-21 E% Xcode % R &

IEFER"Xcode S I BB R FF"

™D

375.2 MB/5.2 GB - A% 3 4k

B 1-22 Xcode # N R

BZmmZE, FHTFRAREXEE, SHELIES Xcode, 2B 1-23 Fimx.
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@
e
"

Launchpad Mission Control

Photo Booth

Time Machine

Wit Xcode, BRETRELHIMARNEN, BT Agree &, SHFTRENRMREDE. W

1-24 F0E 1-25 Firr.

H1-23 BARFEX

Xcode and iOS SDK License Agreement

Yol must agree to both license agreements below in prder to
complete the instaliation and use Xeode. By tlicking Agnt. YOu are

agreeing to the terms of the soft license ag

IMPORTANT: BY USING THIS SOFTWARE, YOU ARE AGREEING TO BE
BOUND BY THE FOLLOWING APPLE TERMS:

A. MAC SDK AND XCODE AGREEMENT
B. j0S SDK AGREEMENT

APPLE INC.

MAC SDK AND XCODE AGREEMENT

PLEASE READ THIS MAC SDK AND XCODE AGREEMENT ("LICENSE")

YOU ARE
AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU
__ARE ACCESSING

| Disagree | [ Agree |

 1-24 Xcode X F T LA E

B 1-25 Xcode EHZRERE

15
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=R S, B LIESE Welcome to Xcode BIEE, B 1-26 Fims, ZEAIFIAILAFFE
Swift FEZIRT -

Welcome to Xcode

Version 6.0.1 5A317)

Ho.Recent Prodects

—) Get started with a playground
157 Expiote new Ideas quickly and easily.

-1 Create a new Xcode project
Start bullding a new iPhone, IPad or Mac application,

f\_/ﬁ Check out an existing project
&{-N Start working on something frorm an SCM repository

M Show this window when Xcode launches  Open another project...

B 1-26 Xcode % R

1.3 HEEF—IMERF

ﬂa—*r Xcode, £F&%! Welcome to Xcode &, 20E 126 Fiax. Swift u:,:.‘IL,U‘-FZi iOS #1 OS

T EENER, MRBERFRENKS, AJLUERE IOS ¥4, ENAILIE iPhone B EETE

“BE’HIJJﬁm MRKBEFAREKRS, TLIERIEE OS X Fa, BIHEEEERTER, thallugsE

iOS SF&iET I0S gkl Swift #2/%. St LB File > New > Workspace #37— M T{E
X, HEEELEFEIN Project EHIE—IS, 0E 1-27 Fims.

Open... File..,
Open Recent Playground... X OQ3N
Open Quickly. .. A

Close Window
Close Taks

from Selectian

Welcome to Xcode

farsion 601 (FA317)

B 1-27 2 Workspace # 1E 45 7= &
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AR RFXNEIE, &% New Folder, ®IA SwifiClass, & Create keIE—EBR, 10
B 1-28 iR

Save As: Untitled.xcworkspace | (ol

FAVORITES Name of new folder:
oy WEER {SwiftClass

%

& T8

Bl =x

Ji 'R

fo i

&} LiuHuiTong
DEVICES |

| Macintosh HD

| Cancel |

[ Cancel | |_save |

B 1-28 4 # Workspace % B %

7E Save As (BN TIEXEZFR 0 SwiftClass, s Save 5oz T1E, B 1-29 Fix.

B 1-29 BITHEK

EHFNTEXA, EMSEX, shRiaaEfE—>I/%E New Project, 21E 1-30 Fix.
i I0S TH “Application”, ZEEAMN TERERIIEXSEE—, 0 “Single View
Application”, 20& 1-31 Fimx.
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Framework & Library
Other
osX
Application
Framework & Library
0] System Plug-in
‘ Other

Show in Finder
Open with External Editor

Open As [
Show File Inspector

New Group from Selection

|
Sert by Name i

Sort by Type ITl
find in Selected Groups...

Source Control

i -

e " I

h (. =2 m ;:
Master-Detail Page-Based Tabbed
Application Application Application

¥

Game !
Single View Application |
This template provides a starting point for an application that uses a single view. It provides
a view controller to manage the view, and a storyboard or nib file that contains the view. Y

r i b —— o - = s
L Fv—*,—-—ﬁw‘ej‘ m . &axﬁ )
- ; gt S|
=0 e SroRe L - ) “ 3 i o

B 1-31 4|# Single View Application ¥ &
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S Next 448, 7E Product Name &g SwiftClassP1C1F3 (P1 {{%&S 1 &5, C1 %
£ 1%, F3A%EE T, XEEEEEDRIBAILAIN TEHKE ), Organization Name {E#NE
CHIEBLRETFR, Organization |dentifier (ZEMNBLRG, FRIR App B, EIRIEBESXERN
Organization Identifier {#%—%. Organization Identifier ETLAFE T2 EFHEX . £ Language T
FueE Swift, 0B 1-32 Fx.

mmqmmulbrvnurmw«t.

Product Name: | SwiftClassP1C1F3 {
Organization Name: |__bttp:/ /www.iphonetrain.com__ |

O com.

Bundie Identifier: com. iphonetrain SwiftClassPIC1F3

L - Swift
Oevices: _ iPhone 3l
_ | Use Core Data

H1-32 flIREXRRE

=t Next EEBREMIF—EERT, B()LES SwiftClass MIER—ZBIE, & 1-33 Ff
=, T Create 52 TF2H00IEE,

T O
Today
. SwiftClass xcworkspace

BH1-33 ®#EREFMLE
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EXERNTLEEEEPNITRERCIESR, WE 1-34 k.

B 1-34 FiRIRFI%x

BEMBERINZE, #EF SwiftClassP1C1F3 I HE T/ ViewController.swift 324, 7
viewDidLoad ;%R , A printin B P5AE, W& 1-35 Fix.

£ Xcode REZL LATELUE, EEREIETHITIZAENEE, 10E 1-36 Fim. XBRER
SwiftClassP1C1F3 T2 iPhone 6 1&#128 .
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= ViewControlier.swift
Running SwiRtClassPICIF3 on Phone &
- . e

D@

=l f M| a s I B s.-mclmncu L2 0w ViewContrallerswift thmcmmuer'
B B—p B L |l-nlvni'7!' 1
SwitClassP1C2F8
il _Frrvesige v 9 import UIKit ‘ Name ViewControlier swift
SuinClassP1C267. Lot | Defautt - Swift Source
o .zm-_.nupu.u 1t class ViewController: UIViewController { frov: Delaih - S Soume
13 Locien RelatvetoGrowp %
! B override func viewDidLoad() { . ViewCootrolier.swift L
W super.viewDidLoad() Full Path /Users/LIUHufTang/
115 // Do any additional setup after an"'s','a;,,
loading the view, typically from SwiftClassPICIF3/
a nib, ViewController,swift ©
1% = —— =
17 Iprintln("welcome Swift Class! "); l é’:mﬁa— X y
:: ¥ 1 ~ SwiRtClassP1C1F3Tests
1 gverride func didReceiveMemoryWarning() { i
1 super.didReceiveMemoryWarning() tem Sasiogn
bl // Dispose of any resources that can ‘ Text Encacing | Defauh - Unicode (UTF-8) &
be reccreated, R s~ v
he} } ‘l 6] (J ’© o
% mmﬂk-amu
e supports the. View-
%} management model In I0S.
7 § - - -
E w0l & + I 0 < seicusicii ]Q s Lt
. Welcome Swift Class! | gt & Smarcy of views.
‘ Table View Controller - A
‘ e COMtrOller that manages a table view.
Al Qutput + & DDlEfQ -

H1-35 #5RKT, WRF—IEF

SwiftClassP1CIFY
A, SwiftClassP1C1F4
A, SwiftClassP1C1FS
A, SwiftClassP1C1F6
e SwiftClassP1C2F1
/A SwiftClassP1C2F2
# SwiftClassP1C2F3
A\ SwiftClassP1C2F4
A SwiftClassP1C2FS
A SwiftClassP1C2F6
o SwiftClassP1C2F7
#\ SwWiIftClassP1C2F8
o\ SwiftClassP1C2F9
7 SwiftClassP1C2F10
A SwiftClassP1C2F11
A SwiftClassP1C2F12
o SwiftClassP1C2F13
A SwiftClassP1C2F14
A SwiftClassP2

YVVY VY YYYYVYVYVYYYYVY VY VR

Edit Scheme...
New Scheme. .
Manage Schemes. ..

T ST R

llOSDevk.e

105 Simulator
8 iPhone 5s (6BFDC72D-FD01-4B62-B376-69AFCEDCECDA)
8 IPhone 5s (5317D554-D745-4302-9A47-DB544785393A)
8 (Phone 6 Plus

¥ Deployment Info

Deployment Target
Devices

Main Interface 'Main

Device Orientation ¥ Portrait

H1-36

& commands + R simA EARITIRHIE
iOS 127, ZdERFFga(ET Ul,

= e

ST

HH E AN E

z7iERr, BERRnhiOS EilgE, RETEENIEE
BSANEE. A EEENEDSNBIUTER Swift FF

7N

&IOS M. BNILERERELXIEITENH T Welcome Swift Class! =4, 20E 1-37 Fi.
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lass ViewController: UIViewController {

- override func viewDidlLoad() {
super.viewDidLoad()

// Do any additional setup after
loading the view, typically from
2 nib.

println(“Welcome Swift Class! );

. pver ?de func didReceiveMemoryWarning()

super.didReceiveMemoryWarning() =
// Dispose of any resources that can
be recreated.

 diuin

B 1-37 #4748 %

1.4 Swift X33

1.4.1 XHaRk

glE “Single View Application” T#2, Xcode £BEmER—LEH, HELEMIIE 1-38 Fix
( TFE&H SwiftClassP1C1F3 ),

SwiftClassP1C1F2

M 1-38 THXHEH
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AppDelegate.swift X4+ R FEEFNEEAEE, NARFERNSRIEZE FH—L5E.
Main.storyboard 2R EEFRIEEO .
ViewController.swift N BIEFEIABIEHIEE, TEOSENZNEIRHIRRIEERS

® |mages.xcassets ENBRFERARFHNESR, TEESE Applcon (APP FFE Icon ).
ATLIAEEME A TR, §—ARaTLUEE deployment target LIR R AN, [EEFASGULLENBUE
#EF.

® LaunchScreen.xib £ Xcodeb/iOS 8 HIFHINEE, MANERE, ERE iOS 8 £,
i0S 8 FhELZEGHE TERA Launchimage, & pk—1~ LaunchScreen.xib, XtftbLABIF—MEREE H
EINRE, TUSH—LSINRRE, XBERHEEERESMATHRSE. EEEEDP, RIIES
SRR LaunchScreen.xib HIfEER .

Swift MABEXRERE, BEX LENEXXAFEBEKIZA AR . FMNEM—LEBEE.
Swift RFFHIAZ RGBT EIZIRF AT, BIEELINFRN, EETLAERE MERIIREED
SANBENREH (B4 Swift FEFXFRRIBNE ). FHITETLURIEESHITFRNE, REIZECSHE
FANSZE, 2NE 1-39 F1E 1-40 Fimso

Show in Finder

Open with External Editor

Open As »
Show File Inspector

Show in Finder

Open with External Editor

Open As >
Show File Inspector

New File...
New Project...
Add Files to “SwiftClassP1C1F3"...

New File. ..
New Project...
Add Files to “SwiftClassP1C1F3"...

Delete Delete

New Group New Group

New Group from Selection New Group from Selection
Sort by Name Sort by Name

Sort by Type Sort by Type

Find in Selected Groups... Find in Selected Groups...

Source Control > Source Control >

Project Navigator Help >

v

Project Navigator Help

B 1-39 fl#ECHE R B 1-40 42>

1.4.2 #RIRFF

WRFRFARIRBPETE. BE. Hix. R 8E. S0k, %, HSEENEF. a3
NHREE—EIE, K9ANE, SwiftClass 5 swiftclass 2R ARIHRAE .
RIRFF (identifiers ) ILUHASHNENFE A 3l Z, TH%_ . EXAZESE (Basic

23
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Multiingual Plane ) #2f9 Unicode. JFEEFHFLUREBEARAZESHLIIMIIFEAKX ( Private Use
Area ) FFIA, BFHTEEREEF.

fFlgn, mySwift, My_Swift. _sys_my. SEEASERWRRRF, M 2room. mail#f] class J93E
EHARAE . B, FX ‘55" S3NEEREEN.

BEEZERRGRHERSEF Unicode F4EE . Unicode Ui —4mi3El, ©8a 7 I
XZFEHB, WP, HX. BXEFF, EEZHMNEWXTEPRER emoji REFS, W
®@ © @2 xUFEEST R Unicode, MIEER, XURFSHE Swift chEBETLAER .

WREBIREBF (reservedword ) fERIRRT, BEEHBIBIBINRSIS . flt0, class F2&
EHWRREE, BRILUER class’ . REISABTHARRFH—3D, s s TRE—FRREF. BEIERX
BHEMRIATE—METFNRIEIR . FRNFTREERXBANETRET .

=PSRN

Let ®=3.1415926

Let _welcome="welcome"
Let _swift &FK="FEREHE"
Let ‘class'="@@n

Let B OROATOUAINEHOIRA IS T

1.4.3 XBF

KEFRENMERBETEHRENNE N REBINAF . XBFETREBERIFNREBZ/F,
FRIERESERS () BEIGER. ERAKRFELT 47,

1. PB{EEBARYXEEE=: class. deinit. enum. extension. func. import, init, let. protocol.
static. struct. subscript. typealias #0 var.

2. BEESGRIXE=: break. case. continue. default. do. else. fallthrough. if. in.
for. return. switch. where #0 while,

3. BfERAFAEBIXEF: as, dynamicType. is. new. super. self, Self. Type.
__COLUMN__, _ FILE_ . _ FUNCTION__ . _ LINE__,

4. BELFTYPHERBHIXETF associativity, didSet, get. infix. inout. left. mutating.
none . nonmutating . operator . override . postfix . precedence . prefix . right. set .
unowned, unowned ( safe ). unowned(unsafe). weak. willSet, XL BFIHIEE F T 24N
LA BB FHARIRGT

XFLidXET, BRiE(lRBLELMECIINE N, BEBCE: £ Swift t, XRFERX
DHXINERY, Bt class 1 Class 24 E, 224 Class 7~2 Swift (%=,
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1.4.4 FEHNRS

® I

B, AERBREHRA—LIARTYA, (EAZICHNECHER, LSRR, Swift B9
RSB ERIF BN BB ERNRE .

Swift FRGERS CiIBSHIERIEREBNL. SMERLSUERATE (/) Hieiatrc:

[ ER—AERE

WAL TEITER, IUESKIIES (/4) Fk, HFUESINASKT (¥) & .
XN BATIER

1. B—ATHER

2. B ATHER

......

......

5 C BES&THFERE, Switt NSTERITUREERMISTERZT . KEMR—TSTIR
R, REEXNERRZ AERERE TSR
/8 1 ADERTTK

/%5 2 MERTT K
B2 MERG R/

B LMERGE
il
BESRESTIR, TG EEERE—ARANE, BIEXBRABTIELSHT 7 STERR,
e 5

S5RMAESFHEESAE, Swit TBFHIEREBFEONERBAFERSS(), MREF—TBEE
ZRIBEDNS, YNERD SR

Let _'dog = «Edr ;println (dog)

/ /it “67

Jjo

1.4.5 KiB3r9196K

Swift {CAB—AREBRMRESESR . k3. PUTEDHERM, WE 1-41 Fin. HPSLHR—13IH, &
LA PFR TR ERNRESFSEEN, PITED —RIFRELIE—ThEEMmSRES.
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]

« > | B SwiftClassP1CIF4 ) {3 SwiftClassPIC1F4 5 = ViewController.swift > [} viewDidLoad

ViewController.swift

SwiftClassP1C1F4 KBS

Created by LiuMingYang on 14-10-4.
Copyright (c) 2014% __ http://www.iphonetrain.com . All rights reserved.

[y
Mo N oW W N e

class ViewController: UIViewController {

13 override func viewDidLoad() {
14 super.viewDidlLoad()
15 // Do any additional setup after loading the view, typically from a nib.

18 //
19 let m = 3.1415926

pi| let _Welcome = " Welcome "
230 let _Swift¥R = "ZLOE" mﬁ%ﬁﬁ

25 let ‘class’ = "@HS"

7 let §="0EQOAVOVLEINOGORI ISR

B 1-41 Swift K&

1.5 (EA#HBEE

1.5.1 @&

BB FEEFILRETETDEN, RESCNESXEPERBRRSE, MEARE, i
Iz, BRSIEPER, BEBERT, XHELEBRAREDH. ELEURSBERNEFNZICRR
MRS, ERRALE, tEAESERRERSMEATARETEFE—THIE,

B—EDMIFEBORNELEZEE, HEFSBREFEREL X, AFSMaFBER
EARUERIEREEN .. APRIENB— TR,

1.5.2 TFTEHR=EE

EAERNMNBATHBE AR, %R Xcode—>Preferences... 8, 2AE%#E Downloads >
Documentation, FEXERLABEIEL FHTRE THINERE, 88 FENEE, TJUBBEET
ﬁ, pu@ 1-42 FEH_TO
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= ViewController. swift
: 490'\0\“ | Build SwiftClassPantd k: Succeeded

Open Developer Tool
Services > e

Hide Xcode #H

[ Hide Others X®H i e LT
Show Al b

Quit Xcode 8 105 7.1 Simulator -
" " 8 /05 7.0 Simulator 7

¥ Documentation

g 105 8 library 438ME @)
& 05X v10.9 doc set AzerME @
@@ Xcode 6 library IG39 M8 @

— — == . = - !

' Check for and install updates automatically | Check and Install Now

Wl e br i rdmt k- o

B 1-42 T8 OH

1.5.3 {&H

TEEWZE, 5 “Window—>Documentation and AP| Reference” $TFF#EBISCRY, & 1-
43 i

Minimize

Zoom
Show Next Tab 38}
Show Previous Tab 1

! Documentation and APl Reference
trolle Welcome to Xcode 31
Devices 382

{ Organizer

Bring All to Front
tup af

v = SwiftClass — + ViewController.swift

B 1-43 4774 B) X4

17, BN EREREENNENGENNSXEEMR . £ Xcode B, —REE—HFRE
RRAEY I0S SCASEE. —ARERRAHY OS X 3#%EE, LAR— Xcode ST#4EE, WM 1-44 k.
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Technical Q&A QA1827
Automating Version and Build Numbers Using agvtool

Q: How do | auto-increment my build and version numbers using

»
A | agvtoo 1?7
L |
> | A: The version and build number keys respectively specify the marketing and Internal versions of your application. agy1ool Is a command-
@ i line tool that allows you to automatically increment these numbers to the next highest number or to a specific number. This document
» provides step-by-step instructions for updating your build and version numbers using agviocl. The "Xcode" and "Command Line" sections
.=wm indicate the steps to be respectively performed in Xcode and the command line.
» 1§ Xcode - B
» g 05 Xv10.9 doc set | Note: The version number, which |s the number shown to your application’s users, identifies a released version of your application, It is ‘
» g Xcode 6 library | stored in your application’s Info.plist as CFBundleShors VerstonString (3undie versions string, sbort). \

The build number identifies an unreleased or released version of your application. kunuﬁlnvommnnnonslnhpﬂslu
CrPusdieVersion (Sundle version), See the Properny List Key for more about these keys.

See Figure 1 for an example showing the version number and the build number of the App Store app, which are respectively 1.3 and 201.4.

Figure 1: App Store application’s version and bulld numbers

F1-44 #WehXHRE

EXHABTRGENNSMEE, BR7XEENSE, TLIERTROXEE, WE 1-45
B e

N

v g 105 8 library
» [l Audio & Video
» [ Cocoa Touch Layer
» [ Core OS Layer
> Core Services Layer
» [ Data Management
» [ General
» [[@ Graphics & Animation
» Languages & Utilities
Mathematical Computation
@ Media Layer
{8 Networking & Internet
@ Performance
i Securty
User Experience
Xcode
» i@ OS X v10.9 doc set
» g Xcode 6 library

yYwy

Yy EUvrYY

B 1-45 #B) X FATKH
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2 . sl \ 4 e i i 7. Cocoa Touch Layer
iOS 8 library I FRILIEFIRSIER, RS EEPIBER o BB Addreazodil

mE-. » [ EventKitul
® Audio & Video—S#4A - > (:dmem
o = =, >
® Cocoa Touch Layer——OS Z2tghmREEEZ—, Cocoa > [ Mapkit

Touch 2. BEIEFR IOS RBRIXHEIELR, ZFFk (OS MMART, FF | » (@ Messageul

REBRNRLIERFG, AEOTIRIBENRERER. | * M NotficationCenter
» [ Photosul

CocoaTouch B #F AddressBookUl ( BBiE A& Ul #E 2L ). > [ Twitter

EventKitUl . GameKit. iAd. MapKit. MessageUl. Notification » [ uit

Center. PhotosUI. Twitter. UIKit 22, #0& 1-46 B, B 1-46 Cocoa Touch &

® Core OS Layer—izy OS B, CESRMERANNZINE. KahflIEAREO . AZET
Mac BEE%, AERERGNESNAE. CBERLURNGFERS. SR XHRE. REFNREES.
oy OS ENIRENtbiRE TEEFIRFERZE/ED . A, HTFEENER, REERNRSRIESR
ZEELIAHIBIAZFNIRE . iPhone OS M TIFZHIEORERFEEIIEERIZEOLE, Phone MAEIE
LibSystem EESRiBENXLEINEE, XLFOEMT: &2 (POSIX &2 ). W4 (BSDsockets ). X
HREEHE. fRf /O, Bonjour 1 DNS RS . MiAEE ( Localelnformation ). RESES. &It
&, 52 Core OS HARML T BFE<iPhoneSDK>/usr/include/, iPhoneSDK 2 SDK g%
=BR.

@ Core Services Layer—ZIUIRSE, ORSENFIBNARMEMASZIRS, MERE
BEERIXLIRSS, tHALZ T RABEZRFPIEAR.

® Data Management—4UEEIE .
General— —f&14HH9|TR
Graphics & Animation——EFZF1E0E .
Languages & Utilities—iE=F1TH, Objective-C fi—L4MS, App Store ISR TESE,
Mathematical Computation—#ZF 118 .

® Media Layer—4K 2, SEEIKR. SMANMTEAR, aTLANBXERAREF LOIZRYT
OZEEAE ., EEENE, AXURAFENNABEEFIIIEE. A iPhone OS SEIES
aTLABGEIN IR E RN EGFIRIE . EIAEEEEREA ( Graphics Technologies, B4& Quartz.
CoreAnimation 1 OpenGLES ), iR (Audio Technologies, &% CoreAudio 1 OpenAL )
FWSAEEAR ( Video Technologies ).

® Networking & Internet——4&(a)gR

® Performance—{%8E,

® Security—%%,

® User Experience—FF{KL .
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® Xcode——Xcode FEIAE.,
FEENSASN A XY EEEERE . LIRS, 08 1-47 B,

o
o e | Technical QA QA1827
Cocoa Toueh Layer | » ) . .
» 1 Core 03 Layer Automating Version and Build Numbers Using agvtool
Care Services Layer |

. B 1-47 e XHAERAE

‘ WNRBEE UlLabel EKp9EXAR, REEELEOSAT, #XEHF Cocoa Touch Layer—
UIKit—Resource, i UllLabel class Resource, HIRAXIGEIE HIHEENDRB . SMEeTLFIE
FERIEE SR, WA UlLabel, tBaTlli$2 UlLabel Class 18N8, W& 1-48 Fix.

e
Tap Hits

UIKit Data. UlLabel

UlKit F UlLabe| Class Reference Uilabel Class Reference

UIKit Fu UlLabel Class Reference Windows & Views

UlLabel Cla Welcome to Swift Welcome to Swift

[# uiLayoutSu

€] Uluxico“é AP| Reference

(8 UiLoicon UlLabel Class Reference UlLabel Class Reference
UlLabel Class Reference Windows & Views

g 3:::::?; Sample Code

UlMarkup B Lister: A Productivity App (Obj-C and Swift) User Experlence

{3 UiMenu B Managed App Configuration General

[@ UMenu B HelloGoodbye: Using the A...PI to Widen Your User Base LIkt

C] umqumgg B AdaptivePhotos: An Adaptive Application UIKit

C) UlMotlond B URLCache Performance

UlMutablet

ummahle!l @ Show All Results

1-48 HHXHBRRLIRE

FEENSASROSHESREMNE 1-49 Fis.
EETIENR, R FEA LR

® Inherits from #&EXER, HEE.
Conforms to E{EtAMX.
Framework BF{t+A4HELE
Declaration #8XIFEH .
Availability M4 I0S RAFFIAT 1 .
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Inherits from: UlView : Wiesponder : NSObject
Cor to: UID WCoond 5 NSCoding, Uiraite: A ontainer, NSObject, L
Framework: UIKit in i0S 2.0 and later, More related items.
Declaration
SWIFT

var text: String?

OBJECTIVE.C

@property(nonatomic, copy) NSString =text

Discussion
This string Is nil by default.

In IOS 6 and later, assigning a new value to this property also replaces the value of the attributedText property with the
same text, albeit without any inherent style attributes, Instead the label styles the new string using the shadowColor,
textAlignment, and other style-related properties of the class.

Import Statement
import UIKit

Availability
Avaliable in iOS 2.0 and Iater.

BH1-49 WERE

XEBENE UlLabel FratBXR0ELE, than Text. font, textColor. textAlignment &, B3 4EAGE
EFoLUBENE, BEENBEIEEFA.

BHWXEFEERERESABRATHELE, KREF Cocoa Touch Layer>UIKit=> Sample
Code, RiI&BHBRSIENDE, =& “Open Project” BIENz{TI#E, WE 1-50 Fix.

Boield ) e ... Documentation - Ac CEl o
Q- uilabel
i' [
» l Audio & Video & ala o
ot bl A8 A A ometerGraph
» W Aaetoonss [Gpen Project
» @ Eventxnul
Last Revision: Version 2.6, 2013-07-15

Upgraded for JOS 6.0, now using Automatic Reference Counting (AR
practices for Objective~C.,
(Full Revision Histary)

Bulld Requirements: i0S 6.0 SDK

Runtime Requirements: 0S5 5.0 or later

Ac sample graphs the mation of the device. It demonstrates how
andhﬂwu:uuQuarrzZDandCamM|maﬂonlopmv|d¢ahlghperfummgmpﬁview It alf
B Alternate Views. that you can use to Isolate the effects of gravity, and a high-pass filter that you can use to rer|

1 Collection View Transition cm\gmomummmmmnmnmmu-lmmmmIM

B 1-50 #ATnHRE

j\
%\
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1.5.4 Quick Help

RRENESHBIHXENTZTEZRTBERANEMAXEIEN . IFEE Xcode NiBmiE=RE, &(E

Option 2, AEREIFEEINXRE, HSIREXREANFEEES, WE 1-51 Fik.

var alLabel:UILabel

Declaration

Description

Avaiiabliity
Declared In

Reference

class UIlLabel : UIView, NSCoding

The UlLabel class implements a read-only text view. You can use this
class to draw one or multiple lines of static text, such as those you
might use to identify other parts of your user interface. The base |
UlLabel class provides support for both simple and complex styling of

the label text. You can also control over aspects of appearance, such as '
whether the label uses a shadow or draws with a highlight. If needed,

you can customize the appearance of your text further by subclassing.

iOS (8.0 and later)
UIKit
UlLabel Class Reference

|

BUEESEME: —EERMEA. NB—NRERPFFEIF. LXH. SEX. AXFNeE

MR LABERTAY .

BMERmERIXEF T2 Cocoa BENAE, MEECABREEAENESZE, LaLURSEXNE

XIER, 0B 1-52 Fii.

1-51 HR#E43 Cocoa Mty A &

n

do22
Gaclaration func testFunc()
Cedared in - ViewControllerswift

override func viewDidLoad() {
super.viewDidlLoad()
// Do any additional setup after loading tH
from a nib.

testFrnc()

printin("Welcome Swift Class! “);

B 1-52 thiE#il g Ty

Command ENNEtrmE, BIRTHHERIRIRAISEEaE 5 iA & e RISk T4

REEIRPRBI—NITERERSTIF Quick Help £, 21E 1-53 Fix, E5EHE] ‘AU

X", SAEHEI “Quick Help” FF<BIET$IFF.




APUREER DR |, WNFEERR , BERFRQQ: 461573687
IRESHEFEpd TE , WBFE |, 1B FR QQ: 461573687

PDFHIVETLH :

ARNAT LIRS FPDFR 7B o0k, TR, U7, 2R, wit, By,
&Y, b, . B EMRIENT, 1 HAA 0000 # b BAH R, JI(E
BEE NG, REGRMEAIRBIMERGEE, —RIRESREHE], WREAH
K, iHEE R TR QQ: 461573687, B QQ: 2404062482,
ANCERD T AR TN TFRERPDE, HLM EARZPDEKZK AR
FER_EARI S, LA RFRQQ. RIPDFHL, T-HEA N, & AR RAEHE
Fltpdfti ok MO T, ARARFEE NN AGTE),

#%FHQQ:2404062482



	封面
	书名
	版权
	前言
	目录
	第1章 Swift开发入门
	1.1 Swift概述
	1.2 搭建开发环境
	1.2.1 开发环境的要求
	1.2.2 系统环境搭建
	1.2.3 Xcode开发工具搭建

	1.3 编写第一个程序
	1.4 Swift代码分析
	1.4.1 文件构成
	1.4.2 标识符
	1.4.3 关键字
	1.4.4 注释和分号
	1.4.5 代码的构成

	1.5 使用帮助文档
	1.5.1 简介
	1.5.2 下载安装
	1.5.3 使用
	1.5.4 Quick Help

	1.6 Swift基础语法
	1.6.1 变量和常量
	1.6.2 基本数据类型及转换
	1.6.3 运算符和表达式
	1.6.4 控制流
	1.6.5 枚举和结构体
	1.6.6 宏定义
	1.6.7 代码规范


	第2章 Swift与Cocoa
	2.1 字符串
	2.1.1 初始化字符串
	2.1.2 字符串常用方法介绍

	2.2 集合类型
	2.2.1 数组
	2.2.2 字典
	2.2.3 集合的可变性

	2.3 解包
	2.4 类
	2.4.1 类和对象
	2.4.2 属性
	2.4.3 方法
	2.4.4 下标脚本

	2.5 函数和闭包
	2.5.1 函数
	2.5.2 闭包

	2.6 初始化与反初始化
	2.7 id兼容性
	2.8 nil对象
	2.9 继承
	2.9.1 继承
	2.9.2 重写

	2.10 扩展
	2.10.1 扩展的定义
	2.10.2 扩展属性
	2.10.3 扩展构造器
	2.10.4 扩展方法
	2.10.5 扩展下标脚本
	2.10.6 扩展嵌套类型

	2.11 协议
	2.12 自动引用计数（ARC）
	2.12.1 自动引用计数的工作机制
	2.12.2 类实例之间的循环强引用及解决办法
	2.12.3 闭包引起的循环强引用及解决办法

	2.13 多线程
	2.13.1 NSThread的使用
	2.13.2 NSOperation和NSOperationQueue的使用
	2.13.3 Grand Central Dispatch（GCD）的使用

	2.14 新特性Playground

	第二部分 实 战
	第3章 UI基础
	3.1 iOS开发平台限制和方式
	3.2 iOS SDK介绍

	第4章 UI开发与控件
	4.1 窗口与视图
	4.1.1 UIScreen、UIWindow和UIView
	4.1.2 界面旋转和大小处理

	4.2 图片资源的使用
	4.3 UILabel
	4.4 UITextField
	4.5 UIButton
	4.6 UITableView
	4.6.1 UITableView基本使用
	4.6.2 UITableView高级使用
	4.6.3 自定义UITableViewCell
	4.6.4 创建分组表

	4.7 UITextView
	4.8 UISegmentedControl
	4.9 UISlider
	4.10 UISwitch和UIStepper
	4.11 UIActivityIndicatorView和UIProg ressView
	4.12 UIAlertView和UIActionSheet
	4.13 UIImageView
	4.14 UIScrollView和UIPageControl
	4.15 UIWebView
	4.16 UIDatePicker和UIPickerView
	4.17 UIToolBar和UISearchBar
	4.18 UINavigationController
	4.19 UITabBarController
	4.20 MVC模式
	4.20.1 MVC介绍
	4.20.2 Xcode实现MVC


	第5章 读写应用程序数据
	5.1 NSUserDefaults和对象归档
	5.2 文件操作
	5.3 SQLite3存储和读取数据
	5.4 Core Data
	5.5 iCloud存储

	第6章 触摸和手势
	6.1 触摸
	6.2 手势（UIGestureRecognizer）

	第7章 多媒体应用
	7.1 照片选择
	7.1.1 相册图片选择
	7.1.2 拍照

	7.2 AV Foundation框架
	7.2.1 系统声音
	7.2.2 AV音频播放器
	7.2.3 AV录音机

	7.3 Media Player框架

	第8章 动画
	8.1 UIView动画
	8.2 CATransition动画
	8.3 transform属性实现动画
	8.4 CABasicAnimation
	8.5 CAKeyframeAnimation

	第9章 网络通信
	9.1 判断网络连接情况
	9.2 网络请求JSON解析
	9.3 Get、Post方式
	9.4 NSURLSession加载数据、下载上传

	第10章 检测设备朝向和移动
	10.1 加速计和陀螺仪
	10.2 判断设备方向和摇晃

	第11章 定位处理与地图
	11.1 CoreLocation
	11.2 MapKit

	第12章 地址薄、短信、邮件、电话
	12.1 地址簿
	12.2 短信、电话、邮件

	第13章 iOS应用本地化
	13.1 本地化字符串
	13.2 本地化图像
	13.3 本地化Xib文件和应用名称

	第14章 OC汇编与迁移
	14.1 Swift、OC互调
	14.2 将Objective-C代码迁至Swift

	第15章 真机调试和发布
	15.1 真机调试
	15.2 发布
	15.2.1 创建证书和描述文件
	15.2.2 上传提交审核


	第16章 推送通知
	16.1 本地推送
	16.2 服务器推送

	总结 546



